Applications Notes for Avaya IP Office 9.0 with AT&T IP Flexible Reach SIP Trunk Service – Issue 1.0

Abstract

These Application Notes describe the steps for configuring Avaya IP Office with the AT&T IP Flexible Reach and IP Flexible Reach-Enhanced Features service using AVPN or MIS/PNT transport connections.

The AT&T IP Flexible Reach is one of the many SIP-based Voice over IP services offered to enterprises for their voice communication needs. The AT&T IP Flexible Reach-Enhanced Features service is a SIP based service which includes additional network based features which are not part of IP Flexible Reach service. The AT&T IP Flexible Reach service allows enterprises in the U.S.A. to place outbound local and long distance calls, receive inbound Direct Inward Dialing (DID) calls from the PSTN, and place calls between an enterprise’s sites.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these Application Notes has been obtained through compliance testing and additional technical discussions. Testing was conducted via the DevConnect Program.
# TABLE OF CONTENTS

1. Introduction ........................................................................................................................................... 4
2. General Test Approach and Test Results ............................................................................................ 4
   2.1. Interoperability Compliance Testing ................................................................................................. 5
   2.2. Test Results and Known Limitations .................................................................................................. 6
   2.3. Support ............................................................................................................................................. 7
3. Reference Configuration ..................................................................................................................... 8
   3.1. Illustrative Configuration Information .............................................................................................. 9
   3.2. Call Flows ......................................................................................................................................... 10
      3.2.1. Inbound ....................................................................................................................................... 10
      3.2.2. Outbound .................................................................................................................................. 11
      3.2.3. Call Forward Re-direction (Diversion Header) ........................................................................ 12
      3.2.4. Coverage to Voicemail ............................................................................................................. 13
4. Equipment and Software Validated ................................................................................................... 14
5. Configure Avaya IP Office .................................................................................................................. 15
   5.1. Physical, Network, and Security Configuration .................................................................................. 16
   5.2. Licensing .......................................................................................................................................... 20
   5.3. System Settings ............................................................................................................................... 21
      5.3.1. System Tab .................................................................................................................................. 21
      5.3.2. LAN Settings ............................................................................................................................. 22
      5.3.3. Voicemail .................................................................................................................................. 26
      5.3.4. System Telephony Configuration .............................................................................................. 27
      5.3.5. System Twinning Configuration ............................................................................................... 27
      5.3.6. System Codecs Configuration .................................................................................................... 28
   5.4. SIP Line ........................................................................................................................................... 29
      5.4.1. SIP Line from Template .............................................................................................................. 29
      5.4.2. SIP Line - SIP Line Tab ............................................................................................................. 32
      5.4.3. SIP Line - Transport Tab ........................................................................................................... 33
      5.4.4. SIP Line - SIP URI Tab .............................................................................................................. 34
      5.4.5. SIP Line - VoIP Tab .................................................................................................................... 35
      5.4.6. SIP Line – T38 Fax ..................................................................................................................... 36
   5.5. Users, Extensions, and Hunt Groups ............................................................................................ 37
      5.5.1. Digital Telephone User 217 ......................................................................................................... 37
      5.5.2. IP Telephone User 501 .............................................................................................................. 39
      5.5.3. SIP Telephone User 520 ........................................................................................................... 42
      5.5.4. Hunt Groups ................................................................................................................................ 44
   5.6. Short Codes .................................................................................................................................... 46
      5.6.1. ARS Code .................................................................................................................................... 46
      5.6.2. Meet-me Conference and Auto-attendant Codes ...................................................................... 47
      5.6.3. Voicemail Retrieval Code ......................................................................................................... 47
   5.7. Incoming Call Routes ................................................................................................................... 48
   5.8. ARS and Alternate Routing ......................................................................................................... 50
   5.9. Privacy / Anonymous Calls and SIP OPTIONS Frequency .......................................................... 52
   5.10. Saving Configuration Changes to IP Office ................................................................................. 53
6. Verification Steps ................................................................................................................................. 54
7. Conclusion ........................................................................................................................................... 54
8. References .......................................................................................................................................... 55
1. Introduction
These Application Notes describe the steps for configuring Avaya IP Office with the AT&T IP Flexible Reach and IP Flexible Reach-Enhanced Features (IPFR-EF) service using AVPN\(^1\) or MIS/PNT\(^2\) transport connections.

Avaya IP Office is a versatile communications solution that combines the reliability and ease of a traditional telephony system with the applications and advantages of an IP telephony solution. This converged communications solution can help businesses reduce costs, increase productivity, and improve customer service.

The AT&T IP Flexible Reach is one of the many SIP-based Voice over IP services offered to enterprises for their voice communication needs. The AT&T IP Flexible Reach-Enhanced Features service is a SIP based service which includes additional network based features which are not part of IP Flexible Reach service. The AT&T IP Flexible Reach service allows enterprises in the U.S.A. to place outbound local and long distance calls, receive inbound Direct Inward Dialing (DID) calls from the PSTN, and place calls between an enterprise’s sites.

**Note** – The solution described in these application notes also applies to the AT&T Business in a Box service.

**Note** - References to the AT&T IP Flexible Reach service in the remainder of this document include AT&T IP Flexible Reach-Enhanced Features as well, unless otherwise specified.

2. General Test Approach and Test Results
The test environment consisted of:
- A simulated enterprise with IP Office, Avaya phones and fax machines (Ventafax application).
- A laboratory version of the AT&T IP Flex Reach service, to which the simulated enterprise was connected via AVPN or MIS/PNT transport.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to the interoperability of the tested products and their functionalities. DevConnect Compliance Testing is not intended to substitute full product performance or feature testing performed by DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of a DevConnect member’s solution.

\(^1\) AVPN uses compressed RTP (cRTP).
\(^2\) MIS/PNT does not support cRTP.
2.1. Interoperability Compliance Testing

The interoperability compliance testing verified basic inbound and outbound call flows along with Enhanced Features with AT&T IP Flexible Reach service. Section 3.2 provides call flows tested for AT&T IP Flexible Reach service.

The compliance testing was based on a test plan provided by AT&T. This test plan examines the functionality required by AT&T for solution certification as supported on the AT&T network. Calls were made to and from the PSTN across the AT&T network.

- AT&T IP Flexible Reach service
  - SIP trunking.
  - Inbound and Outbound calls between AT&T IP Flex Reach service and IP Office endpoints.
  - Call and two-way talk path establishment between PSTN and IP Office phones via the AT&T Flex Reach service.
  - Inbound and outbound dialing including international calls.
  - G.729 and G.711 codecs.
  - Inbound AT&T IP Flex Reach service calls to IP Office that are directly routed to stations, and unanswered, can be covered to Voicemail Pro.
  - Inbound and Outbound T.38 and G.711 Fax using AT&T IP Flexible Reach service and IP Office Group 3 (G3) and Super Group 3 (SG3) fax endpoints.
  - DTMF tone transmission using RFC 2833 between IP Office and the AT&T IP Flex Reach service for:
    - PSTN automated access systems
    - Navigation of Voicemail, auto-attendant and meet-me conference features configured on Voicemail Pro.
  - Basic and supplementary telephony features such as hold, resume, conference and transfer.
  - Call Forward with Diversion Header.
  - Requests for privacy for inbound and outbound calls.
  - SIP OPTIONS monitoring of the health of the SIP trunk.
  - Long Duration Calls.

- AT&T Network IP Flexible Reach-Enhanced Features
  - Network based Simultaneous Ring
  - Network based Sequential Ring (Locate Me)
  - Network based Attended and Unattended Call Transfer using SIP REFER on IP Office
  - Network based Call Forwarding Always (CFA/CFU)
  - Network based Call Forwarding Ring No Answer (CF-RNA)
  - Network based Call Forwarding Busy (CF-Busy)
  - Network based Call Forwarding Not Reachable (CF-NR)
2.2. Test Results and Known Limitations

1. T.38 faxing is supported for G3 faxes but for SG3 fax, when both sides are set to SG3, the inbound calls to IP Office fail. AT&T and Avaya are investigating this issue.

2. IP Office ONLY supports a packet size of 20 msecs. For bandwidth optimization on AVPN, desired packet size is 30 msecs.

3. **IP Office Softphone did not generate RFC2833 DTMF when attempting to navigate menus with an Auto Attendant system utilizing SIP 183 Session Progress signaling** - Some Auto Attendant systems send **183 Session in Progress** in response to an inbound call, and do not send **200 OK** until a menu selection has been made. In these cases, Avaya IP Office Softphone did not generate DTMF SIP Telephone Events when menu selection was attempted (even though appropriate SIP Telephone Event SDP signaling was sent in the initial Avaya IP Office Invite and received in the network 183).

   It should be noted that if the called Auto Attendant system answers at the onset with 200 OK (prior to a menu selection), then the Avaya IP Office Softphone does generate DTMF Telephone Events during menu selection. This issue does not occur with Avaya IP Office desk phones.

4. When an incoming call is forwarded unconditionally by IP Office to an Auto Attendant which sends **183 Session in Progress** instead of **200 OK**, the call is not forwarded successfully.

5. **IP Office and RFC2833 Telephone Event Type not applied to SIP endpoints** – Avaya IP Office R9.0 allows the RFC2833 Telephone Event Type to be specified (System/Codecs tab, see **Section 5.3.6**). While this parameter does apply successfully to native and H.323 endpoints, it is not applied to SIP endpoints.
   - An 1120E SIP telephone and Softphone used Telephone Event Type 101
   - No issues were found during testing as a result of this behavior.

6. **IP Office Direct Media feature issues** - During testing the following issues were found when the Direct Media option was enabled:
   - Initial audio clipping was observed when Direct Media is established (media stream redirected from the Avaya IP Office hardware to the Avaya IP Office endpoint).
   - It was found that when Direct Media was enabled, Avaya IP Office IP endpoints did not send RTP Events.
   - As a result of these issues, the recommended configuration is to have Direct Media disabled (see **Section 5.4.4**).
   - It should also be noted that only Direct Media or T.38 fax is supported on a SIP Line. The use of both features on the same SIP Line is not supported.

7. Attended and Unattended Call Forwarding **may** get a **603 Decline** when **Refer Support** is enabled in **Section 5.4.2**. This may be because Network based REFER feature is not supported in all AT&T IP Flexible Reach service areas. Calls do work but they are actually not being referred by the network, so the CPE continues to be in the middle of the call. It is advisable to disable Refer Support in **Section 5.4.2** to avoid additional signaling.

8. **Emergency 911/E911 Services Limitations and Restrictions** - Although AT&T provides 911/E911 calling capabilities, AT&T does not warrant or represent that the equipment and software (e.g., IP PBX) reviewed in this customer configuration guide will properly operate
with AT&T IP Flexible Reach to complete 911/E911 calls; therefore, it is Customer's responsibility to ensure proper operation with its equipment/software vendor.

While AT&T IP Flexible Reach services support 911/E911 calling capabilities under certain Calling Plans, there are circumstances when that 911/E911 service may not be available, as stated in the Service Guide for AT&T IP Flexible Reach found at http://new.serviceguide.att.com. Such circumstances include, but are not limited to, relocation of the end user's CPE, use of a non-native or virtual telephone number, failure in the broadband connection, loss of electrical power, and delays that may occur in updating the Customer's location in the automatic location information database. Please review the AT&T IP Flexible Reach Service Guide in detail to understand the limitations and restrictions.

2.3. Support
AT&T customers may obtain support for the AT&T IP Flexible Reach service by calling (877) 288-8362.

Avaya customers may obtain documentation and support for Avaya products by visiting http://support.avaya.com. In the United States, (866) GO-AVAYA (866-462-8292) provides access to overall sales and service support menus. Customers may also use specific numbers (provided on http://support.avaya.com) to directly access specific support and consultation services based upon their Avaya support agreements.
3. Reference Configuration

The reference configuration used in these Application Notes is shown in the figure below and consists of several components:

- **IP Office** provides the voice communications services for a particular enterprise site. In the reference configuration, IP Office runs on an IP 500 V2. This solution is extensible to the Avaya IP Office Server Edition platform as well.

- Avaya “desk” phones are represented with Avaya 1616I, 4625 and 9630 IP Telephones running H.323 software, Avaya Digital Phones (1416, T7100 and 7316E), Avaya 6211 Analog Telephone, Avaya SIP Phones (1140E and 1230) and PC based IP Office Softphone. Fax endpoints are represented by PCs running Ventafax software connected by modem to an Avaya IP Office analog port.

- Voicemail Pro provides the voice messaging capabilities in the reference configuration and its provisioning is beyond the scope of this document.

- Outbound calls are originated from a phone or fax provisioned on IP Office. Signaling is sent between IP Office and the AT&T Border Element IP Address.

- Enterprise sites may have additional or alternate routes to PSTN using analog or digital TDM trunks. However these trunks were not used in this reference configuration.

![Figure 1: Reference configuration](image-url)
3.1. Illustrative Configuration Information

The specific values listed in the table below and in subsequent sections are used in the reference configuration described in these Application Notes, and are for illustrative purposes only. Customers must obtain and use the specific values for their own specific configurations.

**Note** - The AT&T IP Flexible Reach service Border Element IP address shown in this document is an example. AT&T Customer Care will provide the actual IP addresses as part of the AT&T IP Flexible Reach service provisioning process.

<table>
<thead>
<tr>
<th>Component</th>
<th>Illustrative Value in these Application Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya IP Office</td>
<td></td>
</tr>
<tr>
<td>Public IP Address</td>
<td>192.168.62.58</td>
</tr>
<tr>
<td>Private IP Address</td>
<td>10.80.130.58</td>
</tr>
<tr>
<td>Avaya IP Office Extensions</td>
<td>207 = Analog</td>
</tr>
<tr>
<td></td>
<td>501,502=H323</td>
</tr>
<tr>
<td></td>
<td>201,217,218=Digital</td>
</tr>
<tr>
<td></td>
<td>504=Softphone</td>
</tr>
<tr>
<td></td>
<td>520,521= SIP phones</td>
</tr>
<tr>
<td>AT&amp;T IP Flexible Reach Service</td>
<td></td>
</tr>
<tr>
<td>Border Element IP Address</td>
<td>135.242.225.200</td>
</tr>
</tbody>
</table>

Table 1: Illustrative Values Used in these Application Notes
3.2. Call Flows
To understand how inbound and outbound AT&T IP Flexible Reach service calls are handled by IP Office, four basic call flows are described in this section.

3.2.1. Inbound
The first call scenario illustrated in the figure below is an inbound AT&T IP Flexible Reach service call that arrive on IP Office, which in turn routes the call to a hunt group, phone or a fax endpoint.

1. A PSTN phone originates a call to an AT&T IP Flexible Reach service number.
2. The PSTN routes the call to the AT&T IP Flexible Reach service network.
3. The AT&T IP Flexible Reach service routes the call to IP Office.
4. IP Office applies any necessary digit manipulations based upon the DID and routes the call to a hunt group, phone or a fax endpoint.
3.2.2. Outbound

The second call scenario illustrated in the figure below is an outbound call initiated on IP Office for delivery to AT&T IP Flexible Reach service.

1. An IP Office phone or fax endpoint originates a call to an AT&T IP Flexible Reach service number for delivery to PSTN.
2. IP Office applies any necessary origination treatment (verifying permissions, determining the proper route, selecting the outgoing trunk, etc.) and routes the call to AT&T IP Flexible Reach service.
3. The AT&T IP Flexible Reach service delivers the call to PSTN.
4. PSTN delivers the call to a phone or fax endpoint.

Outbound - AT&T IP Flexible Reach Service
3.2.3. Call Forward Re-direction (Diversion Header)

The third call scenario illustrated in the figure below is an inbound AT&T IP Flexible Reach service call destined for an IP Office station that has set Call Forwarding to an alternate destination. Without answering the call, IP Office immediately redirects the call back to the AT&T IP Flexible Reach service for routing to the alternate destination.

**Note** – AT&T requires the diversion header when a call is redirected to ATT IP Flexible Reach service telephone number. (see Section 5.4.1).

1. Same as the first call scenario in Section 3.2.1.
2. Because the IP Office phone has set Call Forward to another AT&T IP Flexible Reach service number, IP Office initiates a new call back out to the AT&T IP Flexible Reach service network.
3. The AT&T IP Flexible Reach service places a call to the alternate destination and upon answer, IP Office connects the calling party (PSTN Phone) to the target party (Target Phone).

<table>
<thead>
<tr>
<th>PSTN Phone</th>
<th>1</th>
<th>PSTN</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Office</td>
<td>1</td>
<td>AT&amp;T IP Flexible Reach</td>
<td>3</td>
</tr>
<tr>
<td>Phone with Call Forward</td>
<td>2</td>
<td>Alternate Destination</td>
<td>3</td>
</tr>
<tr>
<td>Target Phone</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Re-directed (e.g. Call Forward) - AT&T IP Flexible Reach Call
3.2.4. Coverage to Voicemail

The call scenario illustrated in the figure below is an inbound call that is covered to voicemail. In this scenario, the voicemail system is Voicemail Pro software installed on a PC.

1. Same as the first call scenario in Section 3.2.1.
2. The IP Office phone does not answer the call, and the call covers to the phone’s voicemail. IP Office forwards the call to Voicemail Pro.
4. Equipment and Software Validated

The following equipment and software was used for the reference configuration described in these Application Notes.

**Note** - Testing was performed with IP Office 500 V2 R9.0, but it also applies to IP Office Server Edition R9.0. Note that IP Office Server Edition requires an Expansion IP Office 500 V2 R9.0 to support analog or digital endpoints or trunks. IP Office Server Edition does not support TAPI Wave or Group Voicemail.

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya IP Office 500 V2</td>
<td>Release 9.0 (829)</td>
</tr>
<tr>
<td>Avaya IP Office Manager</td>
<td>Release 9.0 (829)</td>
</tr>
<tr>
<td>Avaya IP Office Voicemail Pro</td>
<td>Release 9.0 (311)</td>
</tr>
<tr>
<td>Avaya IP Office Voicemail Pro Client</td>
<td>Version 9.0 (311)</td>
</tr>
<tr>
<td>Avaya 1616IP-Series Telephones (H.323)</td>
<td>Release 1.33</td>
</tr>
<tr>
<td>Avaya 9630 IP Telephone</td>
<td>Avaya one-X® Deskphone Edition</td>
</tr>
<tr>
<td></td>
<td>H.323 Version S3.2</td>
</tr>
<tr>
<td>Avaya IP Office Softphone</td>
<td>Release 3.2.3.49 68975</td>
</tr>
<tr>
<td>Avaya 1416 Digital Telephone</td>
<td>-</td>
</tr>
<tr>
<td>Avaya T7100 Digital Phone</td>
<td>-</td>
</tr>
<tr>
<td>Avaya 7316E Digital Phone</td>
<td>-</td>
</tr>
<tr>
<td>Avaya 6211 Analog phone</td>
<td>-</td>
</tr>
<tr>
<td>Avaya 1140E SIP Telephone</td>
<td>04.03.18.00 (SIP1140)</td>
</tr>
<tr>
<td>Avaya 1230 SIP Telephone</td>
<td>04.03.18.00 (SIP1230)</td>
</tr>
<tr>
<td>Fax device</td>
<td>Ventafax Home Version 6.2</td>
</tr>
<tr>
<td>AT&amp;T IP Flexible Reach Service using AVPN or MIS/PNT transport service</td>
<td>VNI 26</td>
</tr>
</tbody>
</table>

| **Table 2:** Equipment and Software Versions                        |
5. Configure Avaya IP Office

This section describes attributes of the reference configuration, but is not meant to be prescriptive. The configuration steps described here are only for the fields where a value was changed. For all the other fields default values are used. Additionally, the screen shots referenced in these section may not be complete at times. Consult reference [IPO-INSTALL] for more information on the topics in this section.

IP Office is configured via the IP Office Manager program. For more information on IP Office Manager, consult reference [IPO-MGR]. From the IP Office Manager PC, select **Start** → **Programs** → **IP Office** → **Manager** to launch the Manager application. A screen that includes the following in the center may be displayed:

**WELCOME to IP Office Administration**

**What would you like to do ?**

- Create an Offline Configuration
- Open Configuration from System
- Read a Configuration from File

Open the IP Office configuration, either by reading the configuration from the IP Office server, or from file. The appearance of the IP Office Manager can be customized using the **View** menu. In the screens presented in this section, the View menu was configured to show the Navigation pane on the left side, and the Details pane on the right side.
5.1. Physical, Network, and Security Configuration

In the reference configuration, the IP Office 500 V2 contains a VCM32 module, COMBO6210/ATM4 module, and a TCM8 module. The VCM32 is a Voice Compression Module supporting VoIP codecs. The COMBO6210/ATM4 was used in this reference configuration to support digital and analog telephones or fax machines. The TCM8 module was used to support heritage Avaya/Nortel digital phone extensions.

The following screen shows the modules in the IP Office used in the sample configuration. To access such a screen, select Control Unit in the Navigation pane. The modules appear in the Details pane. In the screen below, IP 500 V2 is selected in the Navigation pane, revealing additional information about the IP 500 V2 in the Details pane.
In this reference configuration, the IP Office **LAN2** port (labeled as WAN port in Figure 1) is physically connected to the public network at the IP Office customer site. The default gateway for this network is **192.168.62.1**.

1. To add an IP Route in IP Office, right-click **IP Route** from the Navigation pane, and select **New** [not shown]. To view or edit an existing route, select **IP Route** from the Navigation pane, and select the appropriate route from the Group pane. The following screen shows the Details pane with the relevant default route using **LAN2** as configured in **Destination** field (Refer Section 5.3.2).
2. Another route for **10.80.130.0** subnet was added for the enterprise side **LAN1** port (labeled as LAN port in Figure 1) as shown in the screen below. All the IP devices were part of this 10.80.130.x network in this reference configuration.

![Screen showing IP route settings](image)

3. For use of Avaya IP Office Softphone, navigate to File ➔ Advanced ➔ Security Settings and login with proper credentials in the screen shown below.

![Security service user login screen](image)
4. After logging in, navigate to **Services → HTTP** and verify that **Service Security Level** field is set to **Unsecure + Secure**. Note that this action may be service disrupting.

5. When complete, select **File → Configuration** to return to configuration activities.
5.2. Licensing

The configuration and features described in these Application Notes require the IP Office system to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an authorized Avaya sales representative.

To verify that SIP Trunk Channels has sufficient capacity, navigate to **License** in the Navigation pane and confirm a valid license with sufficient Instances **SIP Trunk Channels, Avaya IP endpoints** and **Power User** exist in the Details pane. Power user licenses are required for IP Office softphone (Section 5.5.2).
5.3. System Settings
This section illustrates the configuration of system settings. Select System in the Navigation pane to configure these settings. The configuration in following sections is for reference purposes only.

5.3.1. System Tab
With the proper system name selected in the Group pane, select the System tab in the Details pane. The following screen shows a portion of the System tab. The Name field is used for a descriptive name of the system. In this case, the MAC address is used as the name. The Avaya HTTP Clients Only and Enable SoftPhone HTTP Provisioning boxes are checked to facilitate IP Office Softphone usage.
5.3.2. LAN Settings

In the sample configuration, **LAN2** was used to connect the IP Office to AT&T Network and **LAN1** was used to connect to the enterprise network.

1. Select the **LAN2** tab followed by the **LAN Settings** tab and configure as follows:
   - **IP Address** – Set to **192.168.62.58** which is the IP address of IP Office known to AT&T network
   - **IP Mask** – Set to a valid value e.g. **255.255.255.0**
   - **Primary Trans. IP Address** – Set to **0.0.0.0**
   - **DHCP Mode** – Select the **Disabled** radio button
2. Select the **VoIP** tab as shown in the following screen and configure as follows:

- **SIP Trunks Enable** – Check this box to enable the configuration of SIP trunks
- **RTP Port Range (Minimum)** – Set to 16384 (As required by AT&T)
- **RTP Port Range (Maximum)** – Set to 32766 (As required by AT&T). Although AT&T requires the maximum value to be 32767, IP Office needs an even number to be entered in this field

To prevent possible issues with network firewalls closing idle RTP channels, it is recommended that following be enabled in **Keepalives** section:

- **Scope** - Select **RTP**
- **Periodic Timeout** - Enter 30
- **Initial keepalives** - Select **Enabled**
3. Select the **Network Topology** tab as shown in the following screen and set **Firewall/NAT Type** field to **Open Internet**. With this configuration, STUN will not be used but make sure to leave **STUN Server IP Address** to its default value.

4. Select the **LAN1** tab followed by the **LAN Settings** tab and set **IP Address** of the IP Office on the enterprise side to **10.80.130.58** and **IP Mask** to **255.255.255.0**. Check the **DHCP Mode – Disabled** radio button.
5. Select the VoIP tab as shown in the following screen and configure as follows:
   - **H323 Gatekeeper Enable** – Check this box to allow the use of Avaya IP Phones
   - **SIP Registrar Enable** – Check this box to allow SIP phones and IP Office Softphone usage
   - **Domain Name** – Set to avaya.com. This domain is used for SIP phone configuration.

6. The Network Topology screen is set the same as it was set in **Step 3**. Click **OK** [not shown] to commit.
5.3.3. Voicemail

Avaya IP Office Voicemail Pro was used in the reference configuration as the voicemail platform, running on a Windows desktop. The installation and provisioning of Avaya IP Office Voicemail Pro is beyond the scope of this document. See reference [4] & [5] for more information on installing and provisioning Avaya IP Office Voicemail Pro.

To view/change, select Voicemail tab and configure as follows:

- **Voicemail Type** – Set to Voicemail Lite/Pro from the drop-down list
- **Voicemail IP Address** – Set to 10.80.130.152, the IP Address of the PC running the Voicemail Pro software.
5.3.4. System Telephony Configuration
Select the Telephony tab and in Telephony sub-tab configure as follows:

- **Companding Law** – Select the U-LAW radio button for Switch field and U-LAW Line radio button for the Line field.
- **Inhibit Off-Switch Forward/Transfer** – Uncheck this box so that call forwarding and call transfer to PSTN destinations via the AT&T IP Flexible Reach service can be tested.

5.3.5. System Twinning Configuration
Select the Twinning tab and configure as follows:

- Uncheck the **Send original calling party information for Mobile Twinning** box
- **Calling party information for Mobile Twinning** – Set to blank

With this configuration, and related configuration of Diversion Header on the SIP Line (Section 5.4.1), the true identity of a PSTN caller can be presented to the twinning destination (e.g., a user’s mobile phone) when a call is twinned out via the AT&T IP Flexible Reach service.
5.3.6. System Codecs Configuration

Select the Codecs tab and configure as follows:

- **RFC2832 Default Payload** – Set to **100**
- Codecs in **Unused** column can be moved to **Selected** column by highlighting them and pressing the `>>>` button. The up and down arrow buttons can be used to order the selected codecs.

Note: By default, all IP (SIP and H.323) lines and extensions will assume the system default **Selected** codec list, unless configured otherwise for the specific line or extension. Click **OK** (not shown).
5.4. SIP Line

The following sections describe the configuration of a SIP Line. The SIP Line terminates the CPE end of the SIP trunk to the AT&T IP Flexible Reach service.

The recommended method for creating/configuring a SIP Line is to use the template associated with the provisioning described in these Application Notes. The template is a `.xml` file that can be used by IP Office Manager to create a new SIP Line for SIP trunking with the AT&T IP Flexible Reach service. Follow the steps in Section 5.4.1 to create a SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may need to be updated after the SIP Line is created. Examples include the following:
- IP addresses
- SIP Credentials (if applicable)
- SIP URI entries
- Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary, after the SIP Line is created via the template. The resulting SIP Line data can be verified against the manual configuration shown in Sections 5.4.2 – 5.4.6.

In addition, the following SIP Line settings are not supported on IP Office Basic Edition:
- SIP Line tab – Originator number for forwarded and twinning calls
- Transport tab – Second Explicit DNS Server
- SIP Credentials tab – Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.4.2 – 5.4.5.

5.4.1. SIP Line from Template

1. Navigate to File → Preferences. In the window that appears, verify that the box next to Enable Template Options is checked under the Visual Preferences tab.
2. Copy the template file to the computer where IP Office Manager is installed. Rename the template file to **US_AT&T_SIPTrunk.xml**. The file name is important in locating the proper template file in **Step 5**.

3. Import the template into IP Office Manager. From IP Office Manager, select **Tools → Import Templates in Manager**. This action will copy the template file into the IP Office template directory and make the template available in the IP Office Manager pull-down menus in **Step 5**. The default template location is `C:\Program Files\Avaya\IP Office\Manager\Templates`.

In the pop-up window (not shown) that appears, select the directory where the template file was copied in **Step 2**. After the import is complete, a final import status pop-up window (not shown) will appear stating success or failure. Click **OK** (not shown) to continue. If preferred, this step may be skipped if the template file is copied directly to the IP Office template directory.
4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate to New → New SIP Trunk From Template.

5. In the subsequent Template Type Selection pop-up window, select United States from the Country pull-down menu and select AT&T from the Service Provider pull-down menu as shown below. These values correspond to parts of the file name (US_AT&T_SIPTrunk.xml) created in Step 2. Click Create new SIP Trunk to finish creating the trunk and newly created SIP Line (not shown) will appear in the navigation pane.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration shown in Sections 5.4.2 – 5.4.5.

7. Save the configuration as shown in Section 5.10.
5.4.2. SIP Line - SIP Line Tab

Select SIP Line tab as shown below for Line Number 17 used for AT&T and configure as follows:

- **ITSP Domain Name** – Set to the IP Office LAN1 address (192.168.62.58) configured in Section 5.3.2, Step 1 so that IP Office uses this IP address in the host portion of SIP headers such as the From header and Diversion header.

- **In Service** – Default is checked.

- **Check OOS** – If this box is checked, it enables IP Office to use the SIP OPTIONS method to periodically check the SIP Line and if no response is received, the SIP line is taken out of service. See **Section 5.9** for additional information related to configuring the periodicity of SIP OPTIONS.

- **Send Caller ID** - Select **Diversion Header** from the drop-down list which will ensure that in case alternate destination is N11, NPA-555-1212, or 8xx number, the call can be properly redirected by AT&T Flexible Reach service by inspecting the SIP Diversion header.

- **Refer Support** – Check this box to enable IP Office to use Refer for Network based call transfer scenarios back to PSTN (attended & unattended).

- **Call Routing Method** – Set to **Request URI** (default).
5.4.3. SIP Line - Transport Tab
Select the Transport tab and set the ITSP Proxy Address to the AT&T Border Element IP Address. The Use Network Topology Info parameter is set to LAN 2 which is configured in Section 5.3.2. Default values are used for the other fields.
5.4.4. SIP Line - SIP URI Tab
Select the SIP URI tab and click the Add… button [not shown] to add a new SIP URI. Configure the New Channel section displayed as follows:

- **Local URI, Contact, Display Name and PAI** – Set all these fields to Use Internal Data
- **Registration** - Set to 0: <None>
- **Incoming Group** and **Outgoing Group** – Set to 100

![SIP URI configuration screenshot](image)

In this reference configuration, the single SIP URI shown above was sufficient to allow incoming calls for AT&T DID numbers destined for specific IP Office users via IP Office hunt groups.
5.4.5. SIP Line - VoIP Tab

Select the VoIP tab and configure as follows:

- **Compression Mode** – Set to *Automatic Select* from the drop-down list.
- **Fax Transport Support** – Select *T38* from the drop-down list.
- **DTMF Support** - Set to the default value *RFC2833*.
- **VOIP Silence Suppression** – This box is checked as AT&T Flexible Reach service requires G729b as a preferred codec.
- **Re-invite Supported** – Check to allow for codec re-negotiation in cases where the target of an incoming call or transfer does not support the codec originally negotiated on the trunk.
- **Use Offerer’s Preferred Codec** – Check this box so that the top codec offered to IP Office is used if IP Office supports that codec.
5.4.6. SIP Line – T38 Fax

Select the VoIP tab and configure as follows:
- Unselect the Use Default Values option (not shown).
- T38 Fax Version – Select 0 from the drop-down list.

Since AT&T IP Flexible Reach does not require registration, the SIP Credentials tabs need not be visited. Click OK (not shown) to commit the SIP Line configuration.
5.5. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Hunt Groups will be illustrated. In the interest of brevity, not all users and extensions used will be presented, since the configuration can be easily extrapolated to other users. To add a User, right click on User in the Navigation pane, and select New [not shown]. To edit an existing User, select User and select the appropriate user in the Navigation pane.

5.5.1. Digital Telephone User 217

The following screen shows the User tab for User 217. This user corresponds to a digital phone.
The following screen shows the SIP tab for User 217. In this sample configuration, the SIP Name and Contact parameters are the user part of the SIP URI in the From header for outgoing SIP trunk calls only. The SIP Display Name (Alias) parameter is configured to any descriptive name. If all outgoing calls involving this user should be considered private, then the Anonymous box may be checked to withhold the user’s information from the network. See Section 5.6.1 for an alternate method of using a short code (rather than static user provisioning) to place an anonymous call.

The following screen shows the Extension information for this user. To view, select Extension and the appropriate extension in the Navigation pane.
5.5.2. IP Telephone User 501

The following screen shows the User tab for User 501. This user corresponds to an Avaya 1616 IP Telephone that is configured as Power User with IP Office Softphone features enabled as shown below.

SIP tab for the user with extension 501 was configured similar to user in Section 5.5.1.
The following screen shows the **Voicemail** tab for this user. The **Voicemail On** box is checked, and a voicemail password can be configured in the **Voicemail Code** and **Confirm Voicemail Code** fields.

Select the **Telephony** tab and **Supervisor Settings** sub-tab as shown below. To allow hot desking, enter a **Login Code**.
Select the **Call Settings** tab as shown below. Check the **Call Waiting On** box to allow an IP Office Softphone logged in as this extension to have multiple call appearances (necessary for call transfer).

![Call Settings Tab](image1)

The following screen shows the Extension information for this user, simply to illustrate the **VoIP** tab available for an IP Telephone.

![VoIP Tab](image2)
5.5.3. SIP Telephone User 520

The following screen shows the User tab for User 520. This user corresponds to an Avaya 1140E SIP Telephone.
The following screen shows the Extension information for this user. Note that for a SIP telephone, the IP Address configured for the phone needs to be specified. In this example, 10.80.130.51 was assigned to the Avaya 1140E telephone. All other screens are configured the same way as in Section 5.5.2.
5.5.4. Hunt Groups

Hunt groups were used in this reference configuration to make sure all different endpoints could be exercised for incoming calls on a SIP Trunk from AT&T Flexible Reach service. To configure a new hunt group, right-click HuntGroup from the Navigation pane, and select New (not shown). To view or edit an existing hunt group, select HuntGroup and choose the appropriate hunt group from the Navigation pane.

The following screen shows the Hunt Group tab for hunt group 2317. This hunt group was configured to contain some of the endpoints used in this reference configuration. Since the Ring Mode field is set to Longest Waiting, this will enable the telephones to ring in a round robin fashion with the priority given to the longest waiting member of the hunt group. Edit button can be used to add additional extensions to the User List.
The following screen shows the **SIP** tab for hunt group **2317**. The **SIP Name** and **Contact** are configured with AT&T DID **2482317**. Refer to **Section 5.7** where an incoming call route is mapped to this hunt group for the calls to be delivered to the members of this group.

If required, additional hunt groups can be configured.
5.6. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code, right click on **Short Code** in the Navigation pane, and select **New**. To edit an existing short code, click **Short Code** and select the code to be edited in the Navigation pane.

5.6.1. ARS Code

In this reference configuration, the Automatic Route Selection (ARS) feature was used for outgoing calls. A short code was configured as follows:

- **Code** – Set to 9N for access to ARS
- **Feature** – Select **Dial** from the drop-down list
- **Telephone Number** – Set to N. If this value is set to WN, then the calls sent via this route will be sent as Anonymous.
- **Line Group Id** – Set to 50:Main configured in Section 5.8.

So, when an IP Office user dials **9-1-303-538-1760** IP Office identifies it as an ARS call and refers to the line group setup in this short code. Refer to **Section 5.8** for how the call is handled after it get to the ARS group.
5.6.2. Meet-me Conference and Auto-attendant Codes

Features like Meet-me Conference and Auto-attendant are configured on Voicemail Pro and are beyond the scope of this document. In order to access those features, short codes can be used. In this reference configuration, for meet-me conference and auto-attendant Conference was configured on Voicemail Pro. The following screens show the short code set for these features. Conference module configured in Voicemail Pro handles both the conferencing and auto attendant features and is beyond the scope of this document.

![Conference module configuration](image1)

5.6.3. Voicemail Retrieval Code

To retrieve voicemails left in individual mailboxes, this code was configured in this reference configuration. When a user enters, *17, they can retrieve the messages in their mailbox. Additionally, this short code can be also in the Incoming Call Route configured in Section 5.7.

![Voicemail retrieval code](image2)
5.7. Incoming Call Routes

In this section, IP Office Incoming Call Routes are illustrated. Each Incoming Call Route will map a specific AT&T IP Flexible Reach DID number to a destination user, group, or function on IP Office. To add an incoming call route, right click on **Incoming Call Route** in the Navigation pane, and select **New** [not shown]. To edit an existing incoming call route, select **Incoming Call Route** and the appropriate route in the Navigation pane.

The screen shown below matches the AT&T IP Flexible Reach DID 7323684893 in the **Incoming Number** field on the **Line Group Id** (100). The **Line Group Id** matches the **Incoming Group** field configured in the **SIP URI** tab for the SIP Line to AT&T IP Flexible Reach service in **Section 5.4**.

![Incoming Call Routes](image)
Select the **Destinations** tab and a value can be either selected from the drop-down list or manually entered. In the screen shown below, the hunt group configured in **Section 5.5.4** was selected.

Similarly, in the screen below, an extension configured in **Section 5.5.2** was selection.

The following screen displays how a short code can be manually assigned in the **Destination** field to route the call for voicemail retrieval. Similarly, a short code for Meet-me conference and Auto-attendant features can be used in the **Destination** field to exercise those features.

The following screen displays another mechanism to access the Meet-me conference and Auto-attendant feature without using the short code. The Conference feature was configure in Voicemail Pro and is beyond the scope of this document.
5.8. ARS and Alternate Routing

While detailed coverage of ARS is beyond the scope of these Application Notes, this section includes basic ARS screen illustrations and considerations. In this reference configuration, Automatic Route Selection (ARS) was used rather than the simple short code approach. With ARS, secondary dial tone can be provided after the access code, time-based routing criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically if the primary route or outgoing line group is not available. Although not shown in this section, ARS also facilitates more specific dialed telephone number matching, enabling immediate routing and alternate treatment for different types of numbers following the access code. For example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but other local or service numbers following the access code should prefer a different outgoing line group, ARS can be used to distinguish the call behaviors.
To add a new ARS route, right-click **ARS** in the Navigation pane, and select **New** [not shown]. To view or edit an existing ARS route, select **ARS** in the Navigation pane, and select the appropriate route name in the Group pane.

The following screen shows an example ARS configuration for the route named “Main”. The **In Service** parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form. If the **In Service** box is un-checked, calls are routed to the ARS route name specified in the **Out of Service Route** parameter. IP Office short codes may also be defined to allow an ARS route to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route, and the means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other known service-affecting events for the primary route.

![ARS Configuration Example](image)

Assuming the primary route is in-service, the number passed from the short code used to access ARS (e.g., 9N in **Section 5.6**) can be further analyzed to direct the call to a specific Line Group ID. Per the example screen above, if the user dialed **9-1-303-538-1760**, the call would be directed to Line Group **100**, configured in **Section 5.4.3**. If Line Group 100 cannot be used, the call can automatically route to the route name configured in the **Additional Route** parameter in the lower right of the screen. Since alternate routing can be considered a privilege not available to all callers, IP Office can control access to the alternate route by comparing the calling user’s priority to the value in the **Alternate Route Priority Level** field.
5.9. Privacy / Anonymous Calls and SIP OPTIONS Frequency

To configure IP Office to include the caller’s DID number in the P-Asserted-Identity SIP header, required by AT&T Flexible Reach service to admit an otherwise anonymous caller to the network, the following procedure may be used.

From the Navigation pane, select User and then select the user named NoUser. In the NoUser Details pane, select the tab Source Numbers. Press the Add… button (not shown) to the right of the list of any previously configured Source Numbers. In the Source Number field shown below, type SIP_USE_PAI_FOR_PRIVACY. Click OK.

Similarly SIP OPTIONS frequency was configured by adding another source number by entering SIP_OPTIONS_PERIOD=2 in the Source Number field. This will set the frequency of the SIP OPTIONS message sent by IP Office to 2 minutes.

The following screen displays the Source Numbers configured in this reference configuration.
5.10. Saving Configuration Changes to IP Office

When desired, send the configuration changes made in IP Office Manager to the IP Office server, to cause the changes to take effect. Click the “disk” icon that is the third icon from the left (i.e., common “save” icon with mouse-over help “Save Configuration File”). Click Yes to validate the configuration, if prompted.

Once the configuration is validated, a screen similar to the following will appear, with either “Merge” or “Immediate” selected, based on the nature of the configuration changes made since the last save. Note that clicking OK may cause a service disruption. Click OK if desired.
6. Verification Steps
The following steps may be used to verify the configuration:

- Place an inbound call, answer the call, and verify that two-way talk path exists. Verify that the call remains stable for several minutes and disconnect properly.
- Place an outbound call, answer the call at PSTN phone and verify that two-way path exists. Verify that the call remains stable for several minutes and disconnect properly.
- Place an inbound call to an agent or phone, but do not answer the call. Verify that the call covers to Voicemail Pro and messages can be retrieved using the appropriate short codes.
- Use the Monitor application to monitor the activity on IP Office.
- Use the IP Office System Status application to verify the state of the SIP connection. Launch the application from Start→Programs→IP Office→System Status on the PC where IP Office Manager is installed. Select the SIP line of interest from the left pane. On the Status tab in the right pane, verify that the Current State is Idle for each channel (assuming no active calls at present time). Additionally, System Status application can also be used to verify the extension status, alarms and call status.
- Use the IP Office System Monitor application to monitor activity on IP Office including tracing a call. Launch the application from Start→Programs→IP Office→Monitor on the PC where IP Office Manager is installed.

7. Conclusion
As illustrated in these Application Notes, Avaya IP Office can be configured to interoperate successfully with the AT&T IP Flexible Reach service. This solution provides users of Avaya IP Office the ability to support inbound and outbound calls over an AT&T IP Flexible Reach SIP trunk service connection via AVPN or MIS/PNT transport. Additionally the ability of Avaya IP Office to provide SIP Diversion Header to the AT&T IP Flexible Reach service for certain outbound call scenarios was demonstrated. Also,

The reference configuration shown in these Application Notes is representative of a basic enterprise customer configuration and is intended to provide configuration guidance to supplement other Avaya product documentation. It is based upon formal interoperability compliance testing as part of the Avaya DevConnect Service Provider program.
8. References
This section references documentation relevant to these Application Notes. In general, Avaya product documentation is available at http://support.avaya.com

Document Number 15-601042


Document Number 15-601758


[IPO-VMPROEXAM] IP Office Voicemail Pro Example Exercises, Issue 07c, July 6, 2009
Document Number 15-601138


Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

[ATT_IPFR] AT&T IP Flexible Reach Service Descriptions:
AT&T IP Flexible Reach